
A Guide to Geometry Import and Repair in 

ABAQUS/CAE Version 6.4  

This page describes the following:  

• Using the Elysium direct translators to import parts from CAD systems.  

• Using the Elysium translator plug-ins to import parts from CAD systems.  

• A guide to importing problematic geometry into ABAQUS/CAE.  

Using the Elysium direct translators to import parts from CAD systems. 

ABAQUS provides direct translators that allow you to import parts from the following 

file formats directly into ABAQUS/CAE:  

• CATIA V4: Versions 4.1.9 through 4.2.4  

• Parasolid: Version 7 through 14. A variety of CAD products can generate 

Parasolid-format parts, such as Unigraphics, SolidWorks, Solid Edge, FEMAP, 

and MSC.Patran.  

For more information about the Elysium direct translators, contact your local 

ABAQUS sales office.  

Using the Elysium translator plug-ins to import parts from CAD systems. 

In addition, you can import a part into ABAQUS/CAE using the Elysium Neutral File 

format. ABAQUS provides a translator plug-in from Elysium Inc. that will generate a 

geometry file using the Elysium Neutral File format. The plug-in is available for the 

following products:  

• Pro/ENGINEER Version 2001 and Wildfire  

• I-DEAS Master Series Version 9 and Version 10  

• CATIA V5 Release 9-11  

For more information and to download the plug-ins, refer to the Elysium plug-ins 

web page.  

A guide to importing problematic geometry into ABAQUS/CAE. 

If the appropriate plug-in or direct translator is not available, ABAQUS/CAE allows 

you to import parts from CAD systems using industry-standard formats such as 

IGES and VDA-FS. Unfortunately, the industry standards are not rigid enough to 

guarantee that a part can be imported seamlessly. After you import a part, you may 

have to edit and repair the part to make it usable by ABAQUS/CAE.  



These web pages provide a guide to help you import parts into ABAQUS/CAE and 

repair any geometry that is problematic. We will continue to update these web 

pages with the latest information available to us. In addition, more information on 

importing and repairing parts is available in the printed and online versions of the 

ABAQUS/CAE User's Manual and from the ABAQUS Online Support System. 

The following topics are covered in this guide: 

• What's new in ABAQUS Version 6.4?  

• My import failed. What should I do now?  
• CAD system export options  

• Frequently asked import and repair questions  

If you are using ABAQUS/CAE Version 6.3, you should refer to the following: 

The ABAQUS Version 6.3 geometry import and repair guide. 

What's new in ABAQUS Version 6.4? 

New formats 

You can now import a part from CATIA V5 into ABAQUS/CAE using an Elysium direct 

translator. A plug-in for CATIA V5 is available from Elysium Inc. that will write a 

geometry file using the Elysium Neutral File format. A reader is available for 

ABAQUS/CAE that will read the Elysium Neutral File generated by CATIA. For more 

information, contact your local ABAQUS sales office.  

Miscellaneous changes 

• The repair options now recognize the type of part being imported. As a result, 

ABAQUS/CAE presents only the options that will help you repair the part. In 

addition, ABAQUS/CAE automatically repairs a part during the import 

process when you import a part using the following formats.  

o CATIA V4  

o Parasolid  

o I-DEAS Elysium Neutral File  

o Pro/ENGINEER Elysium Neutral File  

o CATIA V5 Elysium Neutral File  

• Two tools have been added to the Repair toolset that can help you repair 

imported and repaired parts.  

o Repair face normals 

You can repair the face normals of shell and solid imported parts. In 

rare cases the Query toolset reports that the volume of an imported 

solid part is negative. The volume appears to be negative because 

ABAQUS has turned the solid inside out. The Repair face normals will 



flip the normals and turn the solid right side out. An imported shell 

part can contain faces that have normals pointing in opposite 

directions. The Repair face normals tool will align all the normals on a 

shell part. If the face normals are already aligned, this tool will flip all 

the normals so that they remain aligned but point in the opposite 

direction.  

o Repair invalid edges 

In rare cases after you import a part, ABAQUS will report that all of its 

edges are invalid. The Repair invalid edges tool will try to repair the 

invalid edges by recomputing the data that define them. You should 

also use this tool if only invalid edges remain after automatically 

repairing a part.  

• When you import a part from a third-party CAD system, the dimensions of 

the part or the units in which the dimensions are defined may not match the 

rest of your ABAQUS/CAE model. You can make a global change of an 

imported part's dimensions by scaling the part during the import process. 

You can choose from the following options:  

o Choose No scale to maintain the dimensions stored in the file.  

o Choose Use transform from file, including scale to read the scale 

factor, the rotation matrix, and the translation matrix from the file.  

o Choose Multiply all dimensions by, and enter a scale factor.  

• In some cases when you import an IGES- or VDA-FS-format part and select 

the Stitch edges repair option, ABAQUS/CAE imports separate parts as a 

single part. If you toggle on the Separate disconnected regions into 

parts option and copy the imported part to a new part, ABAQUS/CAE will 

separate disconnected regions into separate parts.  

Release Notes 

For more information, see Chapter 5, "Geometry import and repair" in the ABAQUS 

Version 6.4 Release Notes. 

My import failed. What should I do now? 

The following is a list of potential import problems that can be solved while working 

in ABAQUS/CAE. For information about problems that must be solved by the CAD 

system exporting the file, see CAD system export options. 

General problems 

• Import creates an invalid part  

• Import creates an imprecise part  

• Nothing is visible in the viewport  

• Nothing is visible in the viewport after automated repair  



• Mesh fails or has very distorted elements  

• Part still has invalid geometry after automated repair  

• Some faces of the part are visibly incorrect  

• Some faces of the part are very small  

IGES-specific problems 

• IGES overview  

• Import displays: "Failed to read file"  

• Import displays: "This IGES file contains an entity of type 186 which 

sometimes cannot be read"  

• Import displays: "File does not contain entities from which to build a part"  

• There are unwanted visible gaps between some neighboring faces 

Import creates an invalid part 

Possibility Resolution 

The file contains surfaces that are 

not stitched together into a B-rep 

solid body. All IGES parts exported 

without the MSBO option and all 

VDA-FS parts are invalid when 

imported into ABAQUS/CAE. 

To highlight the invalid entities, select Tools 

-> Query and select Geometry validity from 

the Query dialog box that appears. If 

ABAQUS/CAE highlights the entire part or all of 

its vertices, none of the surfaces are 

connected together. Use the automated repair 

process to try and stitch the surfaces together 

and create a valid part. Use the following table 

for help with the options that appear after you 

select Automated repair. 

  

Automated 

repair options  
Result Further Requirements 

Select the 

following :  

• Convert 

to 

analytical 

represent

ation  

• Stitch 

May result in an imprecise 

part. 

You can continue to work with 

an imprecise part; however:  

• ABAQUS/CAE may not 

be able to mesh the part. 

• Some geometry 

operations may fail.  



edges  

Select the 

following:  

• Convert 

to 

analytical 

represent

ation  

• Stitch 

edges  

• Click Yes 

when 

ABAQUS/

CAE asks: 

Do you 

want the 

invalid 

geometry 

deleted 

now?  

ABAQUS/CAE may remove 

some invalid geometry; 

however, the part may still be 

imprecise. 

Use the manual geometry repair 

tools to replace the invalid 

geometry that ABAQUS/CAE 

removed.  For more 

information, see What can I do 

with the manual repair tools? 

Select the 

following:  

• Convert 

to 

analytical 

represent

ation  

• Stitch 

edges  

• Convert 

to precise 

represent

ation  

Selecting all three options 

does not guarantee a valid 

and precise part. In addition, 

selecting the Convert to 

precise representation 

option will slow down the 

repair process significantly. 

You should select this option 

only in conjunction with the 

first two options.  

You can use the shaded 

render style  

tool to look at the effect of the 

automated repair process. A 

face will not shade correctly if 

it does not coincide with the 

underlying surface. In 

Use the manual geometry repair 

tools to remove the shadowed 

faces and create new faces.  If 

many faces are affected, try 

selecting a different Trim 

Curve Preference in the IGES 

Options dialog box, such as 

Always use 3D data. 



addition, hidden lines will 

appear on an undulating face, 

giving a criss-cross 

appearance.  

Select the 

following :  

• Convert 

to 

analytical 

represent

ation  

• Stitch 

edges  

• Convert 

to precise 

represent

ation  

• Click Yes 

when 

ABAQUS/

CAE asks: 

Do you 

want the 

invalid 

geometry 

deleted 

now?  

 

Selecting all three options 

does not guarantee a valid 

and precise part. Trying to 

make the part precise may 

corrupt the data that 

ABAQUS/CAE generates while 

stitching faces. 

Try working with the imprecise 

part created with the first two 

repair options selected. 

ABAQUS/CAE generates a file called abaqus_repair_part.log that reports the 

results of the automatic repair process. For more information, see What does 

automatic repair do? 

Import creates an imprecise part 

Possibility Resolution 

The file contains wires and surfaces 

that are stitched together, but the 

precision is not within the limits of 

To highlight the imprecise entities, select 

Tools -> Query and select Geometry 

precision from the Query dialog box that 



ABAQUS/CAE's native precision. 

For more information, see What is a 

valid and precise part? 

appears.  

If only a few regions of the part are 

imprecise, you can use the manual repair 

tools to remove the imprecise entities by 

removing faces and creating new faces. 

Removing imprecise entities will enable you 

to create partitions or additional shape 

features. An imprecise part is sufficient for 

creating triangular and tetrahedral meshes.  

Nothing is visible in the viewport 

Possibility Resolution 

Try using the automated repair tools to make the part visible. The bounding box 

is affecting the 

display of the 

part.  

Create a datum coordinate system at the origin, and use the 

view manipulation tools to zoom in to the coordinate system. 

The part should become visible if it is near the origin.  If a 

region of the part is not visible, it may be because the view is 

a box with finite dimensions and this region is not within the 

box. 

 

Nothing is visible in the viewport after 

automated repair 

Possibility Resolution 

Automated repair deletes wires.  If the part is two-dimensional and all 

wires, import the part as a sketch. 

Automated repair deforms the part to 

such an extent that it cannot be 

displayed. 

Use only the first two automated repair 

options:  

• Convert to analytical 

representaion  



• Stitch edges  

Mesh fails or has very distorted elements 

Possibility Resolution 

Use the manual repair tools to merge the small face:  

1. From the Geometry Repair Tools, select Remove face 

to remove the unwanted face.  

2. From the Geometry Repair Tools, select Automated 

repair with the Convert to analytical representation 

and Stitch edges options toggled on.  

Very small 

faces or edges 

in part.  

You can use the Mesh module to diagnose the part. Do the 

following to determine which faces fail to mesh:  

1. Select Shape -> Shell -> From Solid from the main 

menu bar to convert the solid into a shell.  

2. Instance the part in the Assembly module.  

3. In the Mesh module, assign Mesh Controls to Tri. Seed 

the part and generate a mesh.  

4. Faces that cannot be meshed by ABAQUS/CAE are an 

indication of small faces or edges. If ABAQUS/CAE displays 

the message Could not mesh face probably due to too 

coarse a mesh size, reduce the seed size and generate 

the mesh again. If you cannot mesh a face with a 

reasonable seed size, you should use the manual repair 

tools to delete or merge the face.  

Part still has invalid geometry after 

automated repair 

Possibility Resolution 



If only a few regions of the part are invalid, try the following:  

• Select Part -> Repair Geometry and select Automated 

repair from the Geometry Repair Tools dialog box that 

appears.  

• Click Yes when ABAQUS/CAE asks; 

Do you want the invalid geometry deleted now?  

• Try to rebuild the missing regions using the shape feature 

tools and the manual repair tools.  

Limitation of 

repair 

algorithm. 
If many regions are invalid, the precision of the geometry is 

probably too low. When you import the part, ABAQUS/CAE 

displays the IGES Options dialog box; the Minimum Resolution 

is displayed in the Header Information.  

To increase the precision and make the part valid, you can try 

clicking the IGES Options button and reducing the Scale Factor 

to a number less than one. The Minimum Resolution will 

indicate the effect of changing the scale factor. Changing the scale 

factor will modify the dimensions of your part, and you must 

adjust all other engineering quantities correspondingly.  

Some faces of the part are visibly incorrect 

Possibility Resolution 

This is a limitation of the 

automated repair 

algorithm. 

Use the manual repair tools to replace faces of the part 

that are visibly incorrect:  

• From the Geometry Repair Tools, select 

Remove face to remove the unwanted face or 

faces. 

• From the Geometry Repair Tools, select 

Create face to recreate each face. 

Select some of the edges of the loop that define 

the face. If branching exists in any of the edges, 

select all the edges that define the face. 

Some faces of the part are very small 



Possibility Resolution 

The part contains 

a small face.  

Use the manual repair tools to merge the small face:  

1. From the Geometry Repair Tools, select Remove 

face to remove the unwanted face.  

2. From the Geometry Repair Tools, select Automated 

repair with the Convert to analytical 

representation and Stitch edges options toggled on. 

IGES 

• What is IGES?  

• What are the IGES options in ABAQUS/CAE?  

• Changing the scale factor  

• Scanning the IGES file?  

• What is in the IGES log file?  

• My IGES import failed. What should I do now?  

What is IGES? 

The Initial Graphics Exchange Specification (IGES) is a neutral data format designed 

for graphics exchange between computer-aided design (CAD) systems. IGES was 

originally developed in 1980 as an ANSI standard, and it remains the most widely 

supported standard for storing graphics information. The original standard was 

designed to exchange two-dimensional drafting data, but the standard has evolved 

to include three-dimensional data using trimmed surface representation. The IGES 

standard also includes B-rep data; a B-rep in an IGES file is called a Manifold Solid 

B-rep Object (MSBO).  

In ABAQUS/CAE you can import IGES-format parts, and you can export parts in 

IGES format. In addition, you can import and export a sketch from an IGES file. For 

a list of the IGES entities supported by ABAQUS/CAE, see "IGES entities recognized 

by ABAQUS/CAE when importing a part or a sketch," Section 14.7.7 in the online 

ABAQUS/CAE User's Manual.  

What are the IGES options in ABAQUS/CAE? 

The IGES Options tabbed page in the Create Part from IGES File dialog box can 

help you obtain a valid model for use in ABAQUS/CAE. 

The IGES Options tabbed page allows you to choose the following:  



• Trim Curve Preference  

• MSBO  

Trim Curve Preference 

Trim curve preference controls how ABAQUS/CAE converts the surface and the trim 

curves into an internal representation of the part. You can choose from the 

following: 

As per IGES file  

This is the default option. When this option is selected, ABAQUS/CAE uses 

either of the following options to decide how the trim curve is defined. 

Information in the IGES file determines which of the two options is used.  

Always use parametric data  

This option computes the trim curve parametrically using the surface on 

which the curve is lying. Each of the data points on the trim curve is located 

by a surface parameter (u, v). ABAQUS/CAE evaluates the surface 

corresponding to the data point, and then generates three-dimensional 

coordinates for the point. 

If the underlying surface has too many sharp deflections that cannot be 

accurately defined parametrically, the trim curve may not lie on the surface 

when ABAQUS/CAE tries to reconstruct the part. This produces a trimming 

error and may result in gaps between edges. 

Always use 3D data  

This option computes the trim curve from the three-dimensional coordinates 

in space. Each of the data points has its own three-dimensional geometrical 

point; as a result the trim curve must be re-evaluated each time the surface 

is moved. The trim curve can move only along the surface. The Always use 

3D data option should allow trim curves to stay with their underlying surface; 

however, this is not guaranteed. The Always use 3D data option consumes 

more memory than the other options; in addition, the import will take longer 

to complete. 

MSBO 

A Manifold Solid B-rep Object (MSBO, entity type 186) is an IGES term for a B-rep 

solid. Like all B-rep solids, the MSBO entity indicates the overall topology of a solid 

entity by referencing all the trimmed surfaces that define the solid.   



For an IGES file to contain an MSBO entity, the CAD package that created the file 

must include the MSBO in the export procedure. I-DEAS and CATIA allow for the 

MSBO entity; SolidWorks does not.  

• If you know that the IGES file does not contain an MSBO entity, you should 

not select the MSBO option from the IGES Options tabbed page.  

• If the IGES file contains an MSBO entity, you should select the MSBO option 

and capitalize on the additional surface connectivity information provided in 

the entity definition.  

• If the IGES file contains an MSBO entity and you do not select the MSBO 

option, the import will fail and ABAQUS/CAE will display the following 

message:  

"This IGES file contains an entity of type 186 which sometimes 

cannot be read"  

Scanning the IGES file 

When you import an IGES-format file, ABAQUS/CAE scans the contents of the file 

before displaying the Create Part from IGES File dialog box. You can then use 

buttons on the IGES Options tabbed page to view the following:  

IGES Header  

The IGES header information includes details about the application that 

wrote the IGES file. It also includes information about the author of the file 

and the date when the file was written, along with the scale, resolution, and 

units.  

Entity List  

An entity can be a geometric entity, such as a point, an arc, or a line. 

Alternatively, an entity can be separate from the geometry, such as a 

comment. IGES allocates a number to each entity; for example, a circular 

arc is entity number 100. The IGES entity list displays a list of each type of 

entity found in the file. The list includes the IGES entity number, a 

description of the entity, and the number found in the file.  

Changing the scale factor 

ABAQUS/CAE uses ACIS to represent a geometric entity. ACIS has a resolution of 

1.E-6; as a result if two vertices are considered coincident, they must be less than 

1.E-6 units away from each other.  

If you import a part from an IGES file and there is a gap slightly larger than 1.E-6 

between two vertices, the model might be imprecise. However, if you reduce the 

scale factor before you import the part, the vertices may become coincident and the 

part will be precise. For example, a scale factor of 0.1 may be sufficient to make an 

imported part precise. This approach should be used with caution; ABAQUS/CAE 



may deform the part if you specify a very small scale factor. Select the Scale tabbed 

page from the Create Part from IGES File dialog box to change the scale factor. 

What is in the IGES log file? 

When you import a part from an IGES log file, ABAQUS/CAE creates a file called 

abaqus_read_iges.log in the directory from which you started the session. The 

IGES log file contains information about the entities that were translated along with 

any problems that were encountered. 

Click here to view the log file from a successful import. 

Click here to view the log file from an unsuccessful import. 

Import displays: "Failed to read file" 

Possibility Resolution 

File does not contain 

any supported 

entities. 

Look at the abaqus_read_iges.log file generated by 

ABAQUS/CAE. This file will be in the directory from which 

you started ABAQUS/CAE.  If there are supported entities 

in the IGES file that ABAQUS/CAE attempted to read, the 

entities are listed at the bottom of the file under the 

heading "Conversion Summaries." If the file does not 

contain any supported entities, you must return to the CAD 

system and export the part in a different format or with 

different options. 

A transcription error 

in the IGES file has 

caused ABAQUS/CAE 

to misread the file.  

At the end of the file abaqus_read_iges.log there is a 

section under the heading Problem IGES Entities that 

lists the entities that ABAQUS/CAE could not read because 

of incorrect syntax. You must return to the CAD system and 

export the part in a different format or with different 

options. 

Import displays: 
"This IGES file contains an entity of type 186 

which sometimes cannot be read" 

A manifold body is a bounded, closed, and finite volume in three-dimensional 

Euclidean space. With Version 5.0, IGES introduced the concept of a manifold body 



in the form of a Manifold Solid B-rep Object or MSBO (IGES entity type 186). An 

MSBO represents a solid that is made up of a set of connected trimmed and 

untrimmed surfaces, edges, and vertices. Additional information in the MSBO 

definition indicates how the surfaces are connected; as a result, an MSBO can 

reduce the amount of stitching that ABAQUS/CAE has to perform to reproduce the 

original solid.  

Possibility Resolution 

File contains an MSBO 

entity. 

Turn on the MSBO option in the IGES Options dialog 

box in ABAQUS/CAE.  

With the MSBO option 

turned on,  the IGES file 

still cannot be read.  

The MSBO entity that the exporting system has written 

to the IGES file still cannot be recognized by 

ACIS.  Return to the CAD system and regenerate the 

IGES file without using the MSBO option.  

"Import displays: "File does not contain entities 

from which to build a part" 

Possibility Resolution 

There are no IGES solid bodies in the 

file. Only IGES files containing entity 

types 144 and 186 can be guaranteed 

to build a solid ACIS entity in 

ABAQUS/CAE. 

Import the file as a sketch. Or return to 

the CAD system and export the part using 

different IGES options. For more 

information, see What are the IGES 

Options in ABAQUS/CAE? 

There are unwanted visible gaps between some 

neighboring faces 

Possibility Resolution 

Incorrect 

trimming 

during import. 

Try a different Trim Curve Preference in the IGES Options 

dialog box.  If you select Always use 3D data, ABAQUS/CAE 

should allow the surface boundary curves to stay within their 

surface boundaries if the IGES file contains such data.  However, 

this option will consume more time and memory than the As per 

IGES file option.  

Do not select Always use 3D data for large models, because the 



import process consumes large amounts of memory.  In some 

cases memory problems will cause some entities not to be read 

and the import will fail before all the IGES entities have been read. 

 

CAD System Export Options 

The following list describes the recommended formats and options that you should 

use when exporting a part from a CAD system. Direct translators are available for 

most of these CAD products that will allow you to import the geometry directly into 

ABAQUS/CAE. ABAQUS recommends that you use these translators rather than 

trying to export to a standard format, such as IGES or STEP. 

CATIA Solutions  

I-DEAS  

HyperMesh  

Pro/ENGINEER  

SolidWorks  

Unigraphics  

AutoCAD  

Other CAD products  

In some cases your imported solid part will still be unusable by ABAQUS/CAE even 

after you use the automatic and manual repair tools. If that is the case, your only 

option is to return to the original CAD system that generated the exported part and 

do the following: 

• Simplify the part.  

• Try different export options. 

CATIA 

You can import CATIA geometry into ABAQUS/CAE using CATIA V5 and CATIA V4.  

Exporting from CATIA V5 

You can use the Elysium CATIA V5 to ABAQUS/CAE geometry translator to 

transfer geomety from CATIA V5 to ABAQUS/CAE. The translator consists of 

a CATIA V5 plug-in that generates an Elysium Neutral File, and an 

ABAQUS/CAE reader that can import the Elysium Neutral File. The plug-in is 

available for CATIA V5 Release 9-11.  



Exporting from CATIA V4 

You can use the ABAQUS direct translators to import a file saved in CATIA V4 

directly into ABAQUS/CAE. If the CATIA V4 direct translator is not available 

at your site, contact your local ABAQUS sales office to request a copy. 

Alternatively, you can export the geometry from CATIA in IGES format.  

Exporting from CATIA V4 to a native CATIA file 

You can import a CATIA V4 geometry file directly into ABAQUS/CAE using the 

direct translators.  

Exporting from CATIA V4 to an IGES-format file 

The default in CATIA V4 is to export the boundary curves as rational 

B-splines (IGES entitity 126). ACIS sometimes has difficulty handling a large 

number of these B-splines. Therefore, it is recommended that you export 

boundary curves as parametric splines (IGES entity 112).  

To export an IGES file from CATIA V4 with parametric splines: 

1. Set the spline option in CATIA to parametric. 

2. Export the part using the CATIA->IGES translator. 

I-DEAS 

You can use the ABAQUS plug-in to export geometry from I-DEAS into an Elysium 

Neutral File that can be imported directly into ABAQUS/CAE. If the plug-in is not 

available at your site, contact your local ABAQUS sales office to request a copy. 

Alternatively, you can export the geometry from I-DEAS into a STEP- or 

IGES-format file that can be imported into ABAQUS/CAE.  

Exporting from I-DEAS using the ABAQUS plug-in 

You can export I-DEAS geometry into an Elysium Neutral File using the 

ABAQUS plug-in. The Elysium Neutral File can then be imported directly into 

ABAQUS/CAE. The plug-in is available for I-DEAS Master Series 9 and 10 NX.  

Exporting from I-DEAS to a STEP- or IGES-format file 

You should try to export a STEP-format file from I-DEAS before you try to 

export an IGES-format file. 

STEP format 

You can use the default settings in I-DEAS when you export to a STEP-format 



file.  

IGES format 

When you export an IGES file from I-DEAS, it is important that the IGES file 

be flavored properly. In most cases ABAQUS/CAE will generate error 

messages when you attempt to import an IGES file written in an incorrect 

flavor. Click here to download the flavor file. This file specifies the settings 

recommended for optimal import and healing in ABAQUS/CAE.  

To export an IGES file from I-DEAS Master Series 8:  

1. Place the ABAQUS flavor file in the directory in which you are running 

I-DEAS.  

2. Start I-DEAS.  

3. From the I-DEAS main menu, select File->Export.  

4. In the Export Selections dialog box, select IGES and click OK.  

5. Select the part that you want to export.  

6. Under the Apply Flavor label, toggle on Local and select HKS as the 

flavor.  

7. Click Start Export. An IGES file is generated in the ABAQUS flavor. 

HyperMesh 

Use the 'JAMA planes' option to export geometry in IGES format from HyperMesh for 

import into ABAQUS/CAE. 

Creating a Valid Pro/Engineer part 

If you see the message shown in the following figure after you regenerate a part in 

Pro/ENGINEER, you may experience problems importing the part into 

ABAQUS/CAE. 

 

The part may have regenerated successfully; however, you should select 

Info->Geom Check from the Pro/Engineer main menu bar to check for problems 

that might cause import into ABAQUS/CAE to fail. 



After you select Info->Geom Check, Pro/ENGINEER displays the Geometry 

Checks dialog box, as shown in the following figure:  

 

The geometry checking process in Pro/ENGINEER looks for the following: 

• Features that are very small compared to the rest of the part.  

• Surfaces being merged that do not match exactly.  

• Radii that are too large to round an edge.  

• Features that refer to an edge that is not present in the geometry.  

• Features that refer to an edge that was already rounded by another feature.  

• Features that refer to an edge that was not created during the last 

regeneration because the part was modified.  

• Features that created an edge and have been deleted.  

• Sections where the beginning or ending position of the section is very close 

to, but not touching, a vertex.  

• Features that create a tiny edge. The feature was sketched on a drafted 

plane, which might be responsible for the problem. A previously existing 

edge was almost completely trimmed away, creating a tiny edge. The system 

could not construct the intersection of the part and the feature.  

• Features that contain self-intersecting surfaces. A surface has overlapping 

geometry.  

• Features that cut tiny pieces from an existing edge or edges. A feature can 

also leave tiny pieces of an existing edge.  

• Surfaces that contain a singularity.  



• Changes that lead to misalignment near points.  

 

Exporting from Pro/Engineer 

You can use the ABAQUS plug-in to export geometry from Pro/ENGINEER into an 

Elysium Neutral File that can be imported directly into ABAQUS/CAE. If the plug-in 

is not available at your site, contact your local ABAQUS sales office to request a copy. 

Alternatively, you can export the geometry from Pro/ENGINEER into a STEP- or 

IGES-format file that can be imported into ABAQUS/CAE.  

Exporting from Pro/ENGINEER using the ABAQUS plug-in 

You can export Pro/ENGINEER geometry into an Elysium Neutral File using 

the ABAQUS plug-in. The Elysium Neutral File can then be imported directly 

into ABAQUS/CAE. The plug-in is available for Pro/ENGINEER Versions 2001 

and Wildfire.  

Exporting from Pro/ENGINEER to a STEP- or IGES-format file 

You should try to export a STEP-format file from Pro/ENGINEER before you 

try to export an IGES-format file. 

STEP format 

When exporting a STEP file from Pro/ENGINEER, it is important that the 

"solids" option is toggled on in the export options. This setting is required 

even for surface geometry because when the "solids" option is selected, the 

topological information about the geometry is exported to the STEP file. 

Having this topological information present in the STEP file will substantially 

increase the chances of success when importing the part into ABAQUS/CAE.  

The Export STEP dialog box containing the optimal settings in Pro/Engineer 

is shown below.  



 

IGES format 

The following list describes some of the problems that you might encounter 

when you import a Pro/ENGINEER IGES-format file into ABAQUS/CAE along 

with the recommended settings to avoid such problems. IGES files are 

described in detail in "Understanding the contents of an IGES file," Section 

14.4, in the ABAQUS/CAE User's Manual.  

Symptom: Poor handling of trimmed and bounded surfaces  

This message indicates that ABAQUS/CAE was unable to create a B-rep solid 

using the trimmed curves. Use the default IGES settings in Pro/ENGINEER, 

and do one of the following:  

• Include the following options in the IGES-specific configuration file 

iges_config.pro: 

• iges_out_trim_deviation 0.000001  

• iges_out_trim_xyz yes  

• intf3d_out_extend_surface no  

Change the trim curve preference in ABAQUS/CAE to Always use 3D 

data. 

• Include the following options in the IGES-specific configuration file 

iges_config.pro: 

• iges_out_trim_xyz no  

• intf3d_out_extend_surface no  



Change the trim curve preference in ABAQUS/CAE to As per IGES 

file. 

Symptom: Entire assembly is read in as one part  

By default, Pro/ENGINEER exports an assembly to a single file containing a 

single part. You can change this behavior by setting a configuration option 

that instructs Pro/ENGINEER to output an assembly to IGES as multiple files 

containing geometry information for each part. This option also instructs 

Pro/ENGINEER to export any assembly features. If you set this option, 

ABAQUS/CAE can import each part individually from the separate IGES files. 

Include the following option in the IGES-specific configuration file 

iges_config.pro: 

• iges_out_assembly_default_mode all_parts 

SolidWorks 

You can use the ABAQUS direct translators to import SolidWorks native Parasolid 

geometry directly into ABAQUS/CAE. If the Parasolid direct translator is not 

available at your site, contact your local ABAQUS sales office to request a copy. 

Alternatively, you can export the geometry from SolidWorks into an ACIS-format 

(.sat) file that can be imported into ABAQUS/CAE.  

Exporting from SolidWorks using the native Parasolid format 

You can import a Parasolid geometry file directly into ABAQUS/CAE using the 

direct translators. ABAQUS/CAE supports Parasolid Version 7 through 14.  

When you save the SolidWorks geometry as a Parasolid file, you must select 

a valid version of Parasolid from the Export Options dialog box, as shown in 

the following figure: 



 

Exporting from SolidWorks 2001 Plus to an ACIS-format file 

When you export an ACIS (.sat) file from SolidWorks 2001 Plus, you should 

accept the default ACIS Version option of 7.0 from the Export Options 

dialog box, as shown in the following figure: 

 
 

Unigraphics 

You must ensure that the Unigraphics part that you are trying to export to 

ABAQUS/CAE is a valid part.  

Creating a valid Unigraphics part 

Before you export a part from Unigraphics, examine the part's geometry to make 

sure that there are no errors corrupting the part. Files generated from corrupt parts 

are the most common cause of problems when importing a part from Unigraphics 

into ABAQUS/CAE.  

To examine a part's geometry in Unigraphics:  



1. From the main menu bar, select Analysis -> Examine geometry. 

The Examine geometry dialog box appears.  

2. Toggle on the options shown below:  

 

3. Click OK. 

Unigraphics will run a check on the part(s) and will give diagnostics of any errors it 

finds. You must fix any errors in the geometry before exporting a part to IGES. 

The ProSTEP website contains more detailed information on checking geometry in 

Unigraphics.  

Exporting from Unigraphics 

You can use the ABAQUS direct translators to import Unigraphics native Parasolid 

geometry directly into ABAQUS/CAE. If the Parasolid direct translator is not 

available at your site, contact your local ABAQUS sales office to request a copy. 

Alternatively, you can export the geometry from Unigraphics into a Step- or 

IGES-format file that can be imported into ABAQUS/CAE.  

Exporting from Unigraphics using the native Parasolid format 



You can import a Parasolid geometry file directly into ABAQUS/CAE using the 

direct translators. ABAQUS/CAE supports Parasolid Version 7 through 14.  

When you save the Unigraphics geometry as a Parasolid file, you must select 

a valid version of Parasolid, as shown in the following figure: 

 

Exporting from Unigraphics to a STEP- or IGES-format file 

You should try to export a STEP 203/214-format file from Unigraphics before 

you try to export an IGES-format file. 

STEP format 

You can use the default settings in Unigraphics when you export to a 

STEP-format file.  

IGES format 

When you write IGES files with Unigraphics, ABAQUS recommends certain 

export settings. These settings will maximize the success rate when 

importing into ABAQUS/CAE. These settings differ significantly from the 

default Unigraphics export settings. Click here to download a file containing 

the recommended settings.  

To export an IGES file from Unigraphics:  

1. Download the recommended settings file. 

2. From the File menu, select File -> Export -> IGES. 

Unigraphics displays the Export IGES dialog box. 

3. In the dialog box, click the Class select button. 

4. In the viewport, click the part that you want to export, and click OK. 



5. Click the Choose settings button.  

6. Select the settings file that you downloaded in Step 1. 

7. Click OK.  

The Unigraphics->IGES translator will be initialized. The time taken to 

translate the part depends on the size and/or the complexity of the part 

being translated.  

AutoCAD 

AutoCAD, like ABAQUS/CAE, uses ACIS as the internal geometry format. Because 

AutoCAD uses ACIS, the ACIS (.sat) file format is the most efficient and reliable 

means of transferring parts between AutoCAD and ABAQUS/CAE.  

To export an ACIS (.sat) file from AutoCAD: 

1. From the File menu in AutoCAD, select Export.  

AutoCAD displays the Export Data dialog box.  

2. In the dialog box, enter a file name and select ACIS (*.sat) from the 

Save as type list.  

3. Click Save.  

4. Select the objects to export, and press Enter.  

Importing geometry from other CAD products into ABAQUS/CAE 

Many CAD products--such as Solid Edge, FEMAP, and MSC.Patran--can generate 

Parasolid-format parts that can be imported into ABAQUS/CAE using the 

ABAQUS/CAE direct translator. ABAQUS/CAE supports Parasolid Version 7 through 

14.  

If the direct translator is not available, you can try to export the part using another 

format. The order of preference is:  

1. ACIS  

2. STEP  

3. IGES  

4. VDA-FS 

 



Frequently asked import and repair questions 

Import  

Q: The IGES Entity Filter list shows unsupported or unknown entities. 

Should I try to import/repair the part in ABAQUS/CAE or try to regenerate 

the part in the CAD package without creating the unsupported entities?  

A: The IGES Options dialog box includes an Entity Filter that lists all the 

IGES entities found in the file. If the Entity Filter includes nongeometric 

entities that are labeled as Unsupported/Unknown, you cannot be sure 

how much of the part has been imported. You should return to the CAD 

system and export the part again with different options; however, if only a 

few entities are missing, you may be able to repair the part using the 

automated and manual repair tools.  

Q: When should I try using the Trim Curve options?  

A: If ABAQUS/CAE displays silhouette lines or shadowy surfaces in shaded 

render mode after you import a part, it is an indication that the trim curves 

were not imported correctly. In general, trying the different Trim Curve 

Preferences will allow ABAQUS/CAE to create the best fit between the 

curve and its surface data.  

Most of the time, the IGES file will have a trim curve preference in the IGES 

Entity 142 record. The trim curve preference is the final item at the end of 

the record; you can determine the preference as follows: 

0 Unspecified 

1 Two-dimensional trim curve 

2 Three-dimensional trim curve 

3 Either curve is equally preferred 

 

Q: When should I use the MSBO option?  

A: If a part has been exported to an IGES file with the MSBO entity, you must 

select the MSBO option in ABAQUS/CAE to read the additional B-rep 

information contained in the file. If you do not know how the IGES file was 

created, ABAQUS/CAE will display a message if the MSBO option is turned 

off and the file contains an MSBO entity. 

Repair 

Q: Does it make any difference if I repair the part during or after import?  



A: No. 

Q: When should I try to use only the "Convert to analytical representation" 

repair option?  

A: You should never use only the Convert to analytical representation 

repair option. You should always select the Convert to analytical 

representation option in conjunction with the Stitch edges option.  

Q: Can I select only the "Convert to precise representation" repair option?  

A: No. ABAQUS/CAE selects the Convert to analytical representation 

option and the Stitch edges option when you select the Convert to 

precise representation option. 

Q: I tried stitching the part, but it is still imprecise. What should I try next?  

A: First use the Query toolset to highlight the imprecise entities. By 

highlighting the imprecise entities, it is easier to judge what action to take. 

You have the following options: 

• If there are many imprecise entities, you should return to the CAD 

system and try to export the file with different options.  

• If the part is small and does not contain many features, use the 

Convert to precise representation option to make the part precise. 

Making the part precise is time consuming and is not always 

successful. In addition, making the part precise may distort the 

geometry.  

• Repair the part using the manual repair tools and stitch the part again.  

• If there are a few imprecise entities, you may be able to continue 

working with the part. If you mesh the part, ABAQUS/CAE will 

indicate the problematic areas.  

Q: Does reducing the feature list help in repairing the part?  

A: If ABAQUS/CAE cannot repair one of the features correctly, reducing the 

feature list may help. In general, the part described in the imported file is 

treated as a single feature. As a result, reducing the feature list may delete 

the part you are trying to import.  

Q: The repair I tried made things worse. What do I do now?  

A: ABAQUS/CAE stores repair operations as features. As a result, you can undo a repair by 
deleting the feature corresponding to the repair. 


